A Two Day Workshop
On
SPSS Training
Statistical Package for Social Sciences

(Guest Lecture Series)
May 07-08, 2013

House: 23 A, Street: 28, F-10/1, Islamabad
Telephone: 0092 51 2112853-4 Fax: 0092 51 2112857
Email: info@frc.com.pk

Acknowledgement
FATA Research Centre holds a series of guest lectures on significant issues of FATA in
collaboration with The Royal Danish Embassy in Pakistan.
The purpose of guest lectures is to enhance the community base knowledge regarding
FATA. Training and workshops on capacity building is also part of the lectures. It was
crucial to train the employees of FRC to achieve this aim with high precision. In the same
connection, a guest lecture was delivered by Management Xtrategizers on SPSS.
FRC is privileged to thank the honorable guest speaker Professor Rana Qudoos, who
skillfully delivered lecture on SPSS during the workshop and to the Management
Xtrategizers that provided us such a resource person.
FRC also would like to thank its employees who participated in the training with great
enthusiasm and attention.
The report is drafted by Engr. Taimur Ali khan (IT Engineer), composed by Miss Rubab
Zahra (Research Associate), assisted by Mr. Asad kamal (Researcher), reviewed by Mr.
Mehran Ali Khan Wazir (Programme Manager) and approved by Dr. Ashraf Ali (President
FRC).

SPSS Training Report 2013 |

i

Contents
Acknowledgement.....……………….………………………………………...……………………………………. i
Table of Contents …………………………………………………………………………………………………… ii
Introduction ..........................................................................................................................................................2
Statistical Package for the Social Sciences (SPSS) ..............................................................................2
Using SPSS for the first Time ........................................................................................................................3
1.

SPSS Views/Windows: ......................................................................................................................3

2.

Defining Variable: ...............................................................................................................................4

3.

Data Entry to the software ................................................................................................................7

Analysis..................................................................................................................................................................8
1.

Introduction to Descriptive Statistics:...........................................................................................8

2.

Frequency Command..........................................................................................................................9

3.

Descriptive command ...................................................................................................................... 11

4.

Cross TAB Command ..................................................................................................................... 12

Introduction to illustrative statistics .......................................................................................................... 14
Graph of Single variables (simple Chart) ................................................................................. 15

1.

2.

a.

Pie Graph ............................................................................................................................................ 15

b.

Bar chart.............................................................................................................................................. 16
Graph of Multi variable (Cluster Chart).................................................................................... 16

List of Participants .......................................................................................................................................... 22
Agenda ................................................................................................................................................................ 23

SPSS Training Report 2013 |

ii

Introduction
Being a research based independent and non-political institute, FATA research centre
attaches immense importance and gives utmost concentration in presenting its products in a
more professional way. With this aim, FRC conducted a training session on SPSS for its
employees to not only enhance their skills but also to able the product presentable on the
national and international forums. These sort trainings are the part of FRC series of capacity
building sessions for its employees and for other eligible professional from FATA.
SPSS is a great tool of data handling and analysis in social sciences research. Other tools
such as excel and other database are also used for the same purpose but SPSS provides an
easy access to descriptive statistics and frequencies (Responses), that gives a wider variety
of charts & graphs, better and more flexible pivot tables and provides a full set of statistical
tests. Using the “Split” function in SPSS, it is relatively easy to create tables and charts for
subsets without doing any extra work. An attractive feature of SPSS is Labeling Data instead
of codes in reports, because the survey software that converts variable Male- into 1 and
variable Female- into 2 doesn’t mean you want to see lots of 1s and 2s in the report. SPSS
provides an accurate result even when some data is missing, while it also provides easy
import functions, unlimited rows for entries and many additional features. In short SPSS
saves time and increases productivity and makes it easy to understand statistical results.

Statistical Package for the Social Sciences (SPSS)
The abbreviation SPSS stands for “Statistical Package for Social Sciences”, that is a
comprehensive system for analyzing data. SPSS package consists of a set of software tools
for data entry, data management, statistical analysis and presentation. SPSS integrates
complex data and file management, statistical analysis and reporting functions. SPSS can
take data from almost any type of file and use them to generate tabulated reports, charts, and
plots of distributions and trends, descriptive statistics, and complex statistical analyses. To
invoke SPSS in the windows environment, select the appropriate SPSS icon. There are
number of different types of windows in SPSS.
It has now officially been named as "IBM SPSS Statistics". Companion products in the same
family are used for survey authoring and deployment (IBM SPSS Data Collection), data
mining (IBM SPSS Modeler), text analytics, collaboration and deployment (batch and
automated scoring services).SPSS makes statistical analysis accessible for the casual user
and convenient for the experienced user. The data editor offers simple and efficient
spreadsheets-like facility for entering data and browsing the working data file.
Basic features of SPSS include:
I.
II.
III.
IV.

It is easy to learn and use
It includes a full range of data management system and editing tools
It provides in-depth statistical capabilities
It offers complete plotting, reporting and presentation features.

Examples in this report have been taken from FRC’s (FATA Research Centre) Third
research study carried out on “Post US/NATO Withdrawal Scenario”, designed by using
SPSS 16.0 version. After going through this report the readers will be able to install SPSS
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and design it for their desired Survey. They will also be able to open SPSS software, define
variables for their survey, enter data to the software and take efficient and reliable Statistical
results according to the data entered.
The report is organized as follows: 1) SPSS Views/ Windows (how to open SPSS for the
first time and understand different windows) 2) define variables for a survey 3) entering data
manually or importing from external sources 4)analyzing their data (Descriptive and
Illustrative Analysis) 5) and at last show some techniques to work with their data etc.

Using SPSS for the first Time
SPSS installation is quite an easy job. Just double click on Software setup and follow the
instructions. After installation one should access SPSS by double clicking its desktop icon.
A window opens, before data editor screen, shown in Figure - 1, gives one an opportunity to
run a self-help tutorial, type in data, run an existing query, create a new query using the data
base wizard, open an existing data source or open another type of file ( file created in MS
Excel). For first time users, one should obviously go for the 2nd option, “Type in Data”.
1. SPSS Views/Windows:
Choosing one of the above mentioned options would go through three types of different
“views”, “Data view”, “Variable View” and “Output View.” One can see the toggle switch
for the first two views at the bottom left hand corner of Figure – 2, while the third view is
used for observing DATA results.
Figure 1

Figure 2

The SPSS Data Editor/Data view is that to
review where the data is entered in order to
carry out statistical analysis. On first view, the
Data Editor looks very much like other
spreadsheets. However, there are a number of
differences. In SPSS the row numbers down
the side of the data entry sheet refer to
participants or cases. In data view the data is
always in numeric form but as far the variable
will not be define the columns will carry the
label ‘var’ but as the data entry process will be
started, it will automatically change the data
view according to the defined variables.
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2. Defining Variable :
Once you install and open SPSS you are now in the position to design your survey. By
designing we mean the definition of variables for your survey and set properties (Attributes)
related to each variable. Variable refer to the survey questions (Age, Gender, Marital
Status, Income etc).There are two main reasons to fully define a variable:


To keep an electronic archive of your data and all its attributes (e.g. complete survey
items; coding scheme)
 To set up your data so that when you start to run analyses, the results and any tables
and graphs you produce will be attractive, complete, and understandable to the
reader.
To start defining variables one should go to variable view by clicking the variable view tab.
In that view sheets in the column headings have now changed from ‘var’ to the ones shown
in Figure – 3:
Figure 3

The sheet is no longer the data entry sheet the user originally was working in; it will now be
set up differently, because now you are in Variable View. Many new users of SPSS get
confused when switching between Data view and variable view sheets. This is because in
data view the variables are in columns so the data should be entered and read moving down
the sheet while in variable view the variable are in rows. Therefore, the variable information
should be entered and read moving across the sheet.
To set upon a scenario and consider how each variable is initialized we will go through the
FRC Research Study as an example. The purpose of the research was to closely
observe/monitor the developments taking place in Afghanistan after post withdrawal of
US/NATO forces, and their effect on FATA. Sixteen different questions including seven
demographic questions (Agency, Age, Gender, Marital Status, Education Religious,
Education Non-Religious and Occupation) are asked from the respondent. A survey of more
than 2000 questioners is done and then analyze in SPSS. It is now clear that our design
should compose of 24 Variables. One extra variable is representing Data Entry Operator
Information. To set up each variable one should set all the attributes of a variable in variable
view according to their design. All attributes are explained below:
Name refers to “variable name”, in row 1, 2, and 3; and so on below the Name column in
Variable view enter the name of your variable. In the FRC research study the variables are
DE Operator, Agencies, Age, Gender, and Marital Status and so on.The first character of
each variable must be a letter. Name is like the shortest identity of a variable(question) i-e
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FRC want to know the changes expected after US/NATO withdrawal a question “A Change
is expected in FATA after the US withdrawal from Afghanistan.” is asked in the
questioner. The question in itself is very long that’s why name refer the shortest title name
possible to the question that may be “expected changes” or Question_6 as this is question
number six or may be some other name.
Type refers to the type of a variable. When you click on TYPE, a dialogue box will open in
which you need to specify the type of variable you have. In the mentioned example we
mainly deal with two variables with are “string” and “numeric” variables.DE Operator and
Age will hold String and Numeric variable respectively in FRC Data; one can set the
variable type accordingly to the design.


STRING variables include letters, and can be used for names or perhaps brief openended responses



NUMERIC variables are numbers. In either case, you’ll need to specify your
variable width. You can do that in the dialogue box, or in the subsequent WIDTH
and DECIMAL columns

Since variable names often tend to be very short LABEL allows one to specify a longer
variable name. For question six of FRC Research Study you can give the full question string.
Variable label play very important role, and will appear on charts or graphs during analysis.
“Data Entered by an Operator” can be a label for variable “DE Operator.”
Value labels provide a method for mapping your variable values to a string label. In this
example, there are three acceptable values for the M-Status variable. A value of 1 means that
the subject is single and a value of 2 means that he or she is married while 3 shows that the
subject has a different marital status . This helps us in the data entry process because it’s a
tough practice to enter strings instead of integers. When the subject clicks the cell and then
clicks on the button with the three dots, a dialogue box will open.
Figure 4
For male write 1 in
value text box and
Male
in
label
textbox and press
Add button.
Similarly place 2 for
female and 3 for
eunuch and add, and
then click on ok
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Figure 5
Missing is also very important attribute of
variables, it refers to a missing data code. This is a
special number treated by SPSS for missing values.
One can set up these values for better statistical
computation. It is not abnormal for a respondent to
skip questions in a survey; a missing attribute is the
result of a question left unanswered. By default
SPSS considers option 1; “No missing values”
which treats blank answers as missing values, also
one can set discrete missing values, option 2nd or
specify a range of missing values. Low 10 and high
20 will consider 10-20 as missing values.

Columns give width to the columns in data view. Normally this would be at least 8 so that
the variable name could appear easily but one can change accordingly. The subsequent
column, Align, allows you to change the presentation so that scores for the variable are leftjustified, right justified, or centered.
Measure refers, for numeric variables, to the level of measurement of one’s variable. It
distinguishes three variables: Nominal, Ordinal and “Scale”.


Nominal: A variable can be treated as nominal when its values represent categories
with no intrinsic ranking (for example, the department of the company in which an
employee works). Examples of nominal variables include region, zip code, and
religious affiliation.



Ordinal: A variable can be treated as ordinal when its values represent categories
with some intrinsic ranking (for example, levels of service satisfaction from highly
dissatisfied to highly satisfy). Examples of ordinal variables include attitude scores
representing degree of satisfaction or confidence and preference rating scores.



Scale: A variable can be treated as scale when its values represent ordered
categories with a meaningful metric, so that distance comparisons between values
are appropriate. Examples of scale variables include age in years and income in
thousands of dollars.

The overall study design of FRC is represented below in Figure – 6. A total of 25 variables
are created to enter data, and analyze it. First variable DE Operator gives the information of
how many questionnaires have been filled by each data entry operator. Agencies variable
holds information regarding to which agency the respondent belongs to. Six demographic
questions, (Age, Gender, M-Status, Edu-Relg, Edu-Non-Relg, and Occupation) records
respondent personal information.
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Moreover Question_6 to Question_22 are the research questions asked from each
respondent.

Figure 6

3. Data Entry to the software
Once all variables are defined completely, it is time to start entering data. As discussed
earlier in the variable definition that a special code is to be assigned to each variable in a
questionnaire. These codes will now be entered for each and every variable in a ll variables
for the questionnaire and so on for others. The data view columns shows that how the
variable (All Question from a Questionnaire) and each row shows the case/respondent.

Figure 7
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For your understanding, let’s take an example from the FRC study, case # 1010, Shahid Zeb
is the DE Operator means that he enter the respondent # 1010 data that show that the
respondent is from Kurram Agency (digit 3 in column agency and row 1010) as 3 is labeled
for Kurram Agency, having age between ‘32-50’, and he is a male because as 1is entered in
gender variable, also from M-status it is clear that he is married. So this is how we label each
question and enter data for that each case. Hope everything is clear up to now. If there is a
question unfilled in the questioner one should leave blank below that question for that case,
and it would be considered as missing by SPSS.

Analysis
Analysis can be made in different ways like descriptive statistics, illustrative statistics,
different statistical test etc. this report present descriptive statistics and illustrative statics.
1. Introduction to Descriptive Statistics:
Descriptive statistics are those that describe the relationship between variables(like finding
the ratio of male and female in a Survey, find their response about a question, accurately
describing large datasets quickly and easily.).The most common descriptive statistics used
are the measures of central tendency (mean, median and mode) and the measures of
dispersion (standard deviation, standard error and variance).
The commands for extracting descriptive statistics come under the “Analyze/Descriptive
statistics” dropdown as show in figure - 8. Various command come under the dropdown,
such as” Frequency”, “Descriptive”, “Explore”,and Crosstabs etc

Figure 8
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2. Frequency Command
The Frequency command allows you to analyze a full range of descriptive statistics
including the measures of central tendency, percentile values, dispersion and distribution.
From the Analyze drop-down menu, select Descriptive Statistics and then Frequencies.
Figure 9
Select Gender or any of the
variables, we are taking Gender as
an example and click on the arrow
button between the variables list and
the Variable(s) box to send it across.
Ensure that the Display frequency
table box is ticked.
Then click OK.

Your output file will show the Statistics Table 1:

Table 1
Where, N tells about the Valid and Missing values
in the Gender column. Clear from the table, FRC 3rd
study is composed of 2051 respondents, Missing are
zero because missing data forms are discarded from
computation.

S tatistics
Gender
N

Valid
M issing

2051
0

The Table– 2 with the heading Gender gives a frequency breakdown for males and females:
Table 2
Gender

Frequency
Valid

M ale
Female
Total

Percent

Valid Percent

Cumulative Percent

1855

90.4

90.4

90.4

196

9.6

9.6

100.0

2051

100.0

100.0

The Frequency column shows a frequency count for each gender (male and female) and
also includes the total count for both. The table also shows percent, valid percent, and
cumulative percent. The different types of percentage are very helpful in analysis they show
clear proportions of each case in a variable. One can find the frequency and percentage for
each and every variable in study.
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The Frequencies command also allows one to carry out other descriptive statistics as shown
below:
 From the Analyze drop-down menu, select Descriptive Statistics and then
Frequencies


Select the variables you wish to include in the descriptive analysis. We will again
use the FRC study as an example. Send any of the variable to the Variable(s) box



Click on the Statistics button of the Frequencies window
Figure 10

 Here you can choose from a range
of descriptive statistics. We have
chosen the Mean, Median, Mode,
and Mode, Sum, Minimum,
Maximum, Std.deviation(standard
deviation) and Variance.
 Click on the Continue button.
 Deselect the Display frequency
tables’ option. As we are only
interested in them erasures of
central tendency here, frequency
tables are not required.
 Click on OK.
Table 3

Statistics
The individuals or Quam will respond

N

Valid

aggressively to the militancy in the post

Peace in FATA can be restored in

withdrawal scenario.

the post US withdrawal scenario by
2051

2051

0

0

M ean

1.78

2.61

M edian

2.00

3.00

2

4

Std. Deviation

.676

1.310

Variance

.457

1.715

M inimum

1

1

M aximum

3

6

3654

5355

M issing

M ode

S um
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For the complete understandings of the above statistic one must go through “FRC 3rd
Research Study and follow all the above steps. In example we are looking statistics only for
question 7 and 13. 1.78 And 2.61 are the means values for question 7 and 13 respectively.
Variance for question 7 is .457 but for question 13 its 1.715 that show that there are a lot a
variation in the data for question 13. Understandings of statistics are beyond the scope of
this report my suggestion for that is to go for Basic Statistics books.

If one wishes to support their descriptive statistics with some charts. The Charts button is
very useful for producing more than one chart at a time, including bar charts, pie charts and
histograms. Histograms can help identify if your variables are normally distributed. In our
example we want to explore the distribution in Question 7 and question 13:


Click on the Charts button. Select the Histograms radio button and also click in the
box for with normal curve



Click Continue



Deselect the Display frequency tables and All the Previous Checked Statistics on
this occasion as we only want the charts and then click OK

Figure 11

The above mentioned graphs show the histogram including Normal curve, that give some
useful information regarding question 7th and question 13th .

3. Descriptive command
The Descriptive command is an alternative way to produce basic descriptive statistics.
However, it does not give as many options as the Frequencies command. From the Analyze
drop-down menu select Descriptive Statistics and then Descriptive. Select variables
‘Question_7’ and ‘Question_13’, send them to Variable(s) box and click O.
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Figure 12

The following table (Table - 4) shows the Descriptive Statistics for the variables
‘Question_7’ and ‘Question_13’:

Table 4
Descriptive Statistics
Minimu
N
The

individuals

aggressively

to

or
the

Quam

will

militancy

in

m

S td.
Maximum

Mean

Deviation

respond
the

post

2051

1

3

1.78

.676

2051

1

6

2.61

1.310

withdrawal scenario.
Peace in FATA can be restored in the post US
withdrawal scenario by
Valid N (list wise)

2051

The Descriptive Statistics table consists of the number of participants (N) and the
Minimum and Maximum Response for each Question. It also shows the Mean and the
Standard Deviation for each variable .
4. Cross TAB Command
Crosstabs is also a useful feature of SPSS; they are used to analyze demographic
information. By demographic information we mean to find the frequencies of dependent
variable (Row Variable) over independent variable (Column Variable). For example we are
taking ‘Age’ as independent variable and ‘Question_7’ as dependent variable.
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Figure 13
 From the Analyze dropdown
menu
select
Descriptive Statistics and
then Crosstabs
 Place Variable ‘Age’ in
row(s) and ‘Question_7’ in
Column(s). One can set
statistics accordingly their
desired output also checked
‘Display Clustered Bar
Charts’
 click on ok

Table 5
Age * The individuals or Quam will respond aggressively to the militancy in the post withdrawal scenario.
Cross-tabulation
The individuals or Quam will respond aggressively to the
militancy in the post withdrawal scenario.
Agree
Age

16-21

Count

Disagree

Don't Know

Total

109

122

30

261

41.8%

46.7%

11.5%

100.0%

295

369

122

786

37.5%

46.9%

15.5%

100.0%

286

419

113

818

35.0%

51.2%

13.8%

100.0%

50

107

28

185

27.0%

57.8%

15.1%

100.0%

740

1017

293

2050

36.1%

49.6%

14.3%

100.0%

% within
Age
22-30

Count
% within
Age

31-50

Count
% within
Age

51+

Count
% within
Age

Total

Count
% within
Age
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This shows that 261 questionnaires have been filled by the people between the ages of 16-21
where 109 responded as ‘Agree’, 122 as ‘Disagree’ and 30 as ‘Don’t know’. Similarly, the
table gives overall frequencies. From the table we can analyze that as the age of respondents
increases their likelihood to agree with the statement significantly decreases.

Figure 14

From the above graph we can also analyze that for all the cases the response of disagree is
more than the other two. Beside cross tabulation one can draw different types of table from
Analyze/tables/custom tables… dropdown menu.

Introduction to illustrative statistics
Illustrative statistics are a visual representation of data. They can be useful tools for
summarizing and comparing some or all data. Illustrative statistics is an easy way to study
general trends of data in graphs rather than trying to interpret numerical information. There
are three ways of obtaining illustrative statistics in SPSS.
1. All types of graphs can be obtained using the Graphs drop-down menu.
2. You are also able to produce some graphs using the Frequencies command as
shown earlier in the report
3. Finally, many statistical test procedures have chart options. But they are beyond the
scope of this report. One can find many tutorials available online and in hard copy
on these.
From the Graphs dropdown select Chart Builder option, the following Window will
appear:
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Figure 15

In the bottom left box one can Select chart type (Bar, Line, Area, Histogram) while clicking
on a type one can also choose sub type. After selecting your desired type just click and drag
the type to the white upper right window.

1. Graph of Single variables (simple Chart)
a. Pie Graph
From Graph/char builders select pie chart and drag it on white window, then drag a
variable from your study to X-Axis or Slice through Box.

Figure 16
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b.Bar chart
Bar chart for the same variable is like in the following Table:

Figure 17

2. Graph of Multi variable (Cluster Chart)
Chart showing data for more than one variable is also available in SPSS. Suppose one of the
researchers at FRC want to analyze Agency wise and Frontier Region wise results for a
variable. Simply go to the chart builder select and drag multiple lines to the white window. I
have used this type of graph out of personal preferences there are several other options (Bar,
Histogram, etc...)

Figure 18
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Figure 19

Working with your Data
One can do a number of operations to their data, to make new variables from the current
variables, sort the existing variables, apply transpose to the existing variables, to transform
their data for different purpose, to select a portion of data for analysis, split and merge data
files etc.
These commands are in the Transpose and Data dropdown. Some of these commands are
discussed for other commands one can visit FRC and References links.
Compute Variables:
The Transform drop-down menu offers a variety of commands which allow you to
transform your data, such as adding scores together or recoding data into a new variable.
Compute command does exactly what its name says; it enables the user to perform
arithmetical operations that usually result in a new variable being produced.
For example, you may have collected data from a questionnaire and need to add make a
variable representing the missing values of a variable, this is possible within the Compute
procedure.
From Transform drop-down select Compute variable (as in Figure - 20):
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Figure 20

A lot can be done in this window, a lot of built in functions are presented in SPSS one can
create new variable of their own choice. The procedure here for selecting a specific function
is to first selecting a function (parent function, lies in “Function group:”) then choose sub
function from “function and special variables” and drag it to numeric expression box. I-e
FRC wants to create a new variable that measure Missing values in a variable. Parent
function case example for finding missing values in a variable is missing values and Subtype Nmiss. By double clicking on Nmiss, expression would appear in Numeric Expression
window. NMISS works with multiple numeric values, whereas MISSING works with only
one value that can be either numeric or character.
Figure 21

SPSS Creates a new Variable by the name
of Missing, One would observe that
missing variable must contain only ones
and zeros. One’s are placed in for that
cases in which there is a missing value for
the variable in Education(a. Religious)
and zero’s for that Valid Cases
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To confirm the operation of missing variable
let it compare with the statistics of variable
Education (a.Relg) with the Statistics of
Missing Variable. From the analysis graph it is
clear that in variable Education(a. Religious)
there are 156 missing while the graph (Figure 22) shown for missing also giving the same
information.

Statistics
Education (a. Religious)
N

Valid

1895

M issing

156

Figure 22

Select Case:
Questioners have been filled by respondents of 7 agencies and 6 FR Regions. Suppose FRC
is interested in analyzing individual Agencies or FR Regions, and comparing that to the
collective agencies response. Select Case command will help them to analyze a specific
case. In FRC Study the Agencies Variable are label form 1=SWA, 2=NWA, 3=KURRUM
… 13=FR Peshawar. Through select case command graphs for SWA and NWA are
computed and compared with the combined FATA Graph (Figures – 23 and 24)
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Figure 23(SWA graph)

Figure 24 (NWA graph)

Figure 25(FATA Graph)

The above mentioned graphs can be created via Select case as shown in Figure - 26
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Figure 26
 From the Data drop-down menu,
select “select case” a window
would appear checked the second
option “if condition is satisfied”
and click the if… button.
 Select case if window will appear in
that write variable name (Agencies
Here) and equate for a case you
want to select i-e 1 for selection
results only from SWA. Then click
continue button.
 After selecting a case simply follow
the analysis step explain earlier for
the specific case.

Similarly you can select for other case:

Figure 27
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Agenda
FRC Guest Lecture Series
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Date

Time
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·

9:00 AM 1:00 PM

SPSS
BASICS

7th May
2013

1:30 PM 2:30 PM

2:30 PM 5:00 PM

· Data entry in SPSS
· Defining Variables in SPSS
· Assigning Value Labels
· Coding
Lunch Break
· Data checking and data
validation
· Data transformations:
creating new variables
· Testing for Reliability and
Validity
·
·

Qualitative
Data
Analysis

08:00 AM 1:30 PM
8th May
2018

Break
Interpretat
ion and
presentatio
n of
Results

1:30 PM 2:30 PM
2:30 PM 5:00 PM

Installation

Missing Data
Descriptive Analysis

· Converting Qualitative data
into Quantitative data
· Simple Regression
· Assumption of Regression
· Normality
· Linearity
· Autocorrelation
Homoscedasticity
Lunch Break
· Multiple Regression
· Logit
· Probit
· Interpretation and
Presentation of the Results
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